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1 Introduction 

“Polygnosis” is an online knowledge platform that can be used to improve access to 

information about the state-of-the-art laser applications and methods on the conservation, analysis 

and diagnosis of cultural heritage (CH) objects. This training tool aims to bridge the gap between 

Conservation and Laser Science and is a collaborative outcome of the Institute of Electronic Structure 

and Laser (IESL) and the Institute of Computer Science (ICS) of the Foundation for Research and 

Technology-Hellas (FORTH) on the basis of research conducted at Forth 

The central objective is to make new knowledge on laser technologies more reachable and 

comprehensible to CH professionals and scholars by spreading lasers’ know-how keys and 

innovations, as well as, by sharing examples of applied laser methodologies in objects and 

monuments. Polygnosis provides a basic introduction, examples of best practices, as well as, a 

semantically linked structured Vocabulary related to the optical and laser-based techniques. 

All the information that Polygnosis presents is stored on “Cultural Heritage Laser Analysis 

and Diagnosis Documentation System” and can be edited by that system. 
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The services/functions of the system are available through web browser (e.g. Mozilla, 
Chrome, and Internet Explorer). Each user has a login name and a password to access the 

system.  

 

 

  

Figure 1 Approximate  snapshot of the system after user login 
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2 System start and user environment  

      To start the system, user should type in the web browser the URL of the system. This URL has 

been given by the system administrator. 

 

Figure 2 Login page of the system 

 

Username and password are also provided to the user by the system administrator. When the user 

has filled all the required fields, he/she should press (click) the Log in key (button). 

In case of mistyping one of the fields, a message appears informing the user about the typing error. 

The user should type again the username and the password. 

When the user logs in to the system the initial screen of the system (Figure 3) appears. It is 

separated in five distinct regions: Best Practice Guide for Technical Examination, Best Practice Guide 

for Laser Cleaning, Glossary, Object and Data. 
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Figure 3 Initial screen of the system 

After logging in to Polygnosis, users can navigate into the website through the five basic units 

that are provided in the main screen. They can search for a Glossary term, an Object or Data by 

selecting the respective unit. They can also search for examples of evidences found with specific 

technical examinations or laser cleaning in order to gain a better understanding of laser based 

applications.  

Given that the website receives content from the Cultural Heritage Laser Analysis and Diagnosis 

Documentation System, the connections between entities that have been described in that system 

are also applied in the website. This means that users can navigate, for example, from a record of a 

specific data object to a related glossary term or to an object as well as to related examples of Best 

Practice Guide for Technical Examinations or Laser Cleaning. 
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3 Navigating the educational website 

The initial screen of the system has five basic clickable regions as they presented in the image below. 

 

Figure 4  Approximate screen of the five basic regions of the system 

 

After clicking a region from above, the system will guide the user through the knowledge 

information which is stored in the Cultural Heritage Laser Analysis and Diagnosis Documentation 

System. Subsequently, we describe this navigation and the actions that are available to the user. 
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 Best Practice Guide 3.1
 

This section consists of two regions one for Technical examinations and another for Laser 

cleaning. These two regions have the same structure but they contain and represent different 

knowledge information. 

 

 Best Practice Guide for Technical examination  3.1.1

 

Figure 5  Approximate screen of Best Practice Guide for Technical Examination 

 

This instructional Best Practice Guide for Technical examination contains cases of applied 

laser techniques and methodologies in CH objects. Conservation issues are matched with optical and 

laser-based techniques in the table of the main screen of the Best Practice Guide. Table rows describe 

the conservation issues and evidences found on a CH object and columns describe which technique 

was used.  For instance users can find examples of pigment recognition with the use of Raman and 

Laser Induced Breakdown Spectroscopy (LIBS), Individual layers' mapping with the use of 

Multispectral Imaging, Structural diagnostics with the use of Holographic Interferometry etc.  

The Best Practice Guide’s purpose is educational and aims in distributing the information but 

also to encourage users to share examples of their own experiments and case studies. Next to every 

technical examination there is a sign of two arrows. Clicking on it permits to group on the top all the 

examples of the specific column. By clicking the button for a second time the examples return to their 

initial position which depends on the alphabetical order of the related Evidences on the left. 
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Figure 6  Approximate screen of specific examples using Raman technique 

 

 

By clicking on the link “See More” of a specific case, appears a short description and a 

general purpose of the used technique application and its results. Users can navigate to related 

glossary terms (green font color) or related bibliographical references. At the bottom of the page a 

list of related examples is provided and users can continue the navigation to one of those examples 

by clicking on the link. 
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Figure 7  Approximate screen of specific example using Raman technique 

 

By clicking on the link of an example,  the record for this example appears. Here the specific 

examination is described and the outcomes of the process are also provided in the sections called 

“documentation” and “diagnosis”. Images and comments included in the documentation field are 

outcomes of the Technical examination. Images and comments included in the diagnosis field are also 

outcomes of the Technical examination that were used for the detection of the evidences. Users can 

zoom in and zoom out all images of this record by clicking on them. 

 In this record, users can also find related glossary terms or related bibliographical references and 

navigate to them by clicking on the links.  
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 Best Practice Guide for Laser Cleaning  3.1.2

 

 

Figure 8  Approximate screen of Best Practice Guide for Laser Cleaning 

 

This instructional Best Practice Guide for Laser Cleaning consists of cases of applied laser 

cleaning techniques and methodologies in CH objects. Cleaning studies, applications and conservation 

issues are matched with laser cleaning device types in the board below.  

 

 This section can be navigated in the exact same way as the Best Practice Guide for Technical 

examination described in the previous chapter. 
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Figure 9  Approximate screen of specific examples using Laser Cleaning with VIS Wavelength 

 

By clicking on the link “See More” of a specific case, appears a short description of the used 

cleaning study or technique application and its results. Users can navigate to related glossary terms 

(green font color) or related bibliographical references. At the bottom of the page a list of related 

examples is provided and users can continue the navigation to one of those examples by clicking on 

the link. 
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Figure 10  Approximate screen of specific example using Laser Cleaning with VIS Wavelength 

 

 By clicking on the link of an example,  the record for this example appears. Here the specific 

study or cleaning application is described. The structure of this page is similar to the one of the 

examples of applied laser techniques and methodologies in CH objects. 
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 Glossary terms, Objects and Data   3.2
 

 

 

Figure 11  Approximate screen of  

 

Glossary, Objects and Data units have a different structure from “Best Practice guide” and the 

navigation in these units is realized differently.  Those units purpose is mainly to help users to find 

specific records. Clicking on any of the units Glossary, Object and Data, a list with all the respective 

records will appear. Users can sort the records alphabetically and can define the number of results 

per page. 
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 Records for Glossary Terms, Objects and Data  3.2.1

Figure 12  Record of an CH Object  

 

 

Clicking on the title of a record, the full view of the record  appears. In every record the 

creation date of the record and the last modification date are provided. That records include 

information that is withdrawn from the Cultural Heritage Laser Analysis and Diagnosis Documentation 

System and is related to the examples provided in the Best Practice guide sections. Thanks to 

connections between the entities, users can navigate between records and see the related glossary 

terms, objects, data etc. 
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 Searching for Glossary Terms, Ojects and Data  3.2.2

 

 

Figure 13  Filteringsearching or sorting the CH Object records  

 

 

 

 

In case  users want to limit their search they can realize keyword searches or select one or 

more filters on the left side of the list. Filters help to limit and specify the results of a search.  For 

example during an object search, users can limit their search and retrieve only the records where oil 

paintings are described. 
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 Advanced Search   3.2.3

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 14  Advanced search for CH Object  

 

In addition in Object and Data unit, users can choose the advanced search that permits them to 

make even more specific searches. In the advanced search screen, a list of fields appears. These 

fields can be filled in by selecting a term from the list of controlled terms or manually. In certain 

fields users can select more than one terms from the list while in some others they are restricted to 

choose only one. If the term needed is not appearing in the list, it means that no relevant information 

has been introduced in the system. 
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4 Introducing and editing the content of the 

educational website 

Users to which have been given administrational rights can add, remove and edit the content of the 

educational website. The introduction and editing of the information is accomplished through the 

“Diagnosis” Cultural heritage laser analysis and diagnosis documentation system. 

The entities that are used for presentation in the “Polygnosis” educational website are located under 

the entities that are used for documentation and are divided with a line. The Object and Digital Object 

entity is used for documentation and presentation purposes concurrently and is placed at the top of 

the entity menu with the documentation entities. 

The description of usage of the “Diagnosis” Cultural heritage laser analysis and diagnosis 

documentation system can be found in “Cultural Heritage Laser Analysis and Diagnosis 

Documentation System” User Editor Manual Version 1.0 in http://www.ics.forth.gr/isl/KRHPIS-

POLITEIA/educational-material/EditorManual_v11.pdf  

In the following image the entities that are responsible for Polygnosis are in red box. 

 

In continuation the entities and the content of their records is described in detail. 

 
 

http://www.ics.forth.gr/isl/KRHPIS-POLITEIA/educational-material/EditorManual_v11.pdf
http://www.ics.forth.gr/isl/KRHPIS-POLITEIA/educational-material/EditorManual_v11.pdf
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5 Description of common structures  and entities used 

for documentation and presentation purposes 

Concepts common in all the records of entities, are presented and described in this chapter. 

The description has a specific structure. The explanation of the structure and the notation used 

follows.  

[DE]: stands for Definition of field and refers to the scope note describing the concept of the 

field, Functional or Information Unit. 

[TY]: describes the type of the field whether it is simple or compound 

[FI]: stands for Field Input and describes the way of entering the data (e.g. manual, controlled 

vocabulary) 

[OB]: stands for obligation and denotes whether the completion of the field is necessary, 

obligatory or optional 

[MU]: stands for multiplicity of the field and denotes the number of values that the field in 

question can take (e.g. unique or multiple) 

[DC]: stands for data constraint and denotes the type of inserted data (e.g. string, numerical, 

of specific syntax) 

 [RE]: indicates that the specific field can be selected for use in the Examination Report 

 

When an item of the above structure doesn’t have any meaning for the describing concept it is   

noted the term not applicable (na).  

 Card Identity 5.1
 

             [DE] This functional unit contains the metadata of the record of a specific Entity, [TY] 

compound [FI] na, [OB] na, [MU] unique, [DC] structure,  

 It breaks into the following: 

<CardNumber> [DE] this information unit contains all information related to the 

Identification number of the record,  [TY] compound,  [FI] na, [OB] na, [MU] unique, 

[DC]structure,  

             It breaks into the following: 

<IdentificationNumber> [DE] is necessarily used as the card’s identification code 

number (id). It serves the technical organization of the scheme. This type of 

information is essential for connecting the card to any informational section, [TY] 

simple, [FI] automatically, [OB] na, [MU] unique, [DC] string  

<Category> [DE] this field is related to the category of the identification 

number, [TY] simple, [FI] controlled vocabulary, [OB] na, [MU] unique, [DC] 

string 

<AttributedBy>  [DE] this field stands for the person that edited the record 

information, [TY] simple, [FI] connection to the Person Entity, [OB] optional 

[MU] unique, [DC] na 
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<AttributionDate> [DE] this field stands for the date that the record was 

created, [TY] simple, [FI] date from calendar, [OB] optional, [MU] unique 

[DC] numerical 

<ExpiryDate> [DE] this field stands for the date that the record should 

expire, [TY] simple, [FI] date from calendar, [OB] optional, [MU] unique, 

[DC] numerical 

<LastModified>[DE] this field stands for the last date that the record was modified,   

[TY] simple, [FI] date from calendar, [OB] optional, [MU] unique, [DC] numerical 

<Scientific Supervisor> [DE] Contains information for the scientific responsible of the edition, 

[TY]  simple, [FI] connection to the Person Entity, [OB] optional, [MU] unique, [DC] na,  [CO] 

CIDOC CRM (E73 Information Object: P94 was created by: E65 Creation: P14 carried out by 

(performed): E21 Person) 

<Scientific Associates> [DE] Contains information for the scientific associates of the edition,     

[TY]simple, [FI] connection to the Person Entity [OB] optional, [MU] multiple, [DC] na, [CO] 

CIDOC CRM (E73 Information Object: P94 was created by:E65 Creation: P14 carried out by 

(performed): E21 Person: P14.1 in the role of: E55 Type) 

 Bibliographic Reference 5.2
 

    [DE] It contains the connection to the bibliographic references entity and the exact 

reference to the object [TY] compound [FI]na [OB] optional, [MU] multiple, [DC] structure 

          It breaks into the following: 

<Chapter> [DE] contains in text format the chapters of the publication/book referred to the 

documented object, [TY]simple [FI]manual  [OB] optional, [MU] unique, [DC] string [CO] 

CIDOC CRM (E31 Document: P3 has note: E62 String) 

<Pages> [DE] contains in text format the pages of the book, article, journal, etc., [TY] 

simple [FI] manual [OB] optional, [MU] unique, [DC] string [CO] CIDOC CRM (E31  

Document: P3 has note: E62 String) 

<Drawings> [DE] Holds in text format information for the drawings included in the project, 

          [TY] simple [FI] manual [OB] optional, [MU] unique, [DC] string [CO] CIDOC CRM (E31 

          Document: P3 has note: E62 String) 

<Tables> [DE] Holds in text format the tables referred to the documented object, [TY] 

simple [FI] manual [OB] optional, [MU] unique, [DC] string [CO] CIDOC CRM (E31 

Document: P3 has note: E62 String) 

<Link> [DE] contains a link with the complete bibliographic record, [TY] simple [FI] 

controlled vocabulary [OB] optional, [MU] unique, [DC] link to the  Bibliography  entity  

[CO] CIDOC CRM (E73 Information Object: P67 refers to /is referred to by: E1 CRM Entity) 

           <Photos> [DE] holds in text format any information concerning the photographs included in 

the document, [TY] simple [FI] manual  [OB]optional, [MU] unique, [DC] string [CO] CIDOC 

CRM (E31 Document: P3 has note: E62 String) 
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 Object 5.3

As mentioned above this entity is used for documentation and presentation reasons 

simultaneously. The fields used only for documentation, that are not presented in the “Polygnosis” 

website are marked with a light grey color. 

An Object has to be linked with an “Example” entity in order to appear in the “Polygnosis” 

website. The linking is made at the field “Object involved” of the “Example” entity. That way only 

objects that are related to specific examples of conservation or studies, appear in the “Polygnosis” 

website. 

 

 Basic Object Information  5.3.1

 

      [DE] in this funcional unit is documented the basic information about the project  

[TY] compound,  [FI]na,  [OB] optional, [MU] unique,  [DC] na 

It breaks into the following: 

         <ObjectCodeInformation> [DE] this information unit includes information of the object 

code [TY] compound  [FI] na, [OB] optional, [MU] multiple, [DC] structure 

            It breaks into the following: 

           <Code> [DE] the code of the Object [TY] simple [FI] manual, [OB] optional, 

[MU] unique, [DC] string, [RE] can be chosen for use in the Report 

          <Category> [DE] the type or category of the Object’s code [TY] simple [FI] 

controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list 

           <AtributedBy> [DE] the person that attributed the code. Connection to the 

entity “Persons”, [TY] simple [FI] controlled vocabulary, [OB] optional, [MU] 

unique, [DC] link to the  Persons  entity 

          <AttributionDate> [DE] the date that the Object’s code was attributed [TY] 

simple [FI] choose date from calendar, [OB] optional, [MU] unique, [DC] date 

          <ExpiryDate> [DE] the date that the Object’s code will expire [TY] simple [FI] 

choose date from calendar, [OB] optional, [MU] unique, [DC] date 

           <ObjectTitle> [DE] in this field the editor can add the main title of the Object [TY] 

simple [FI] na, [OB] optional, [MU] unique, [DC] structure, [RE] can be chosen for 

use in the Report 

           <OtherObjectTitle> [DE] in this field the editor can add any other titles of the Object 

[TY] simple [FI] na, [OB] optional, [MU] multiple, [DC] structure 

                         It breaks into the following: 

           <Title> [DE] a title of the Object [TY] simple [FI] manual, [OB] optional, 

[MU] unique, [DC] string 

           <AtributedBy> [DE] the person that attributed the title. Connection to the 

entity “Persons”, [TY] simple [FI] controlled vocabulary, [OB] optional, [MU] 

unique, [DC] link to the  Persons  entity 
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         <ObjectCategory> [DE] the type or category of the Object [TY] simple [FI] controlled 

vocabulary, [OB] optional, [MU] unique, [DC] term from list, [RE]Can be chosen for 

use in the Report 

         <In/Out> [DE] in this field the editor can state if the Object is inside IESL(in)or if it has 

been returned to the owner (out) [TY] simple [FI] controlled vocabulary, [OB] 

optional, [MU] unique, [DC] term from list 

         <CaracteristicImage> [DE] in this information unit the editor can add an characteristic 

image of the Object and a comment about it [TY] compound [FI] na, [OB] optional, 

[MU] multiple, [DC] na,[RE] can be chosen for use in the Report 

                         It breaks into the following: 

           <File> [DE] a characteristic image of the Object. Connection to the entity 

“Digital Objects”, [TY] simple [FI] controlled vocabulary, [OB] optional, [MU] 

unique, [DC] link to the  Digital Object  entity 

           <Note> [DE] any comment about the image of the Object [TY] simple [FI] 

manual, [OB] optional, [MU] unique, [DC] string 

         <IncludedIn> [DE] if the Object is the part of another object the editor can add here 

the main object [TY] compound [FI] na, [OB] optional, [MU] unique, [DC] na 

                         It breaks into the following: 

           <LinktoMainObject> [DE] the main Object in which the Object of this record 

is included. Connection to the entity “Objects”, [TY] simple [FI] controlled 

vocabulary, [OB] optional, [MU] unique, [DC] link to the Object  entity 

         <Composition> [DE] if the Object is composed of parts the editor can add here the 

         information about them [TY] compound [FI] na, [OB] optional, [MU] unique, [DC] na 

                         It breaks into the following: 

           <KindofComposition> [DE] the kind of the composition [TY] simple [FI] 

controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list 

           <OverallNumberofParts> [DE] contains the number of components (as a 

numerical indication) [TY] simple [FI] manual, [OB] optional, [MU] unique, 

[DC]numerical 

           <PartInformation> [DE] contains information describing every component 

part of the Object [TY] compound [FI] na, [OB] optional, [MU] multiple, [DC] 

structure 

                         It breaks into the following: 

           <Name> [DE] contains the name of the component [TY] simple [FI] 

manual, [OB] optional, [MU] unique, [DC] string 

<Type> [DE] contains the type of the component [TY] simple [FI] 

manual, [OB] optional, [MU] multiple, [DC] string 

           <Description> [DE] contains the description of the component [TY] 

simple [FI] manual, [OB] optional, [MU] unique [DC] string 

          <NumberofSimilarParts> [DE] contains the number of other similar 

components contained in the same composition (as a numerical 
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indication) [TY] simple [FI] manual, [OB] optional, [MU] unique, 

[DC]numerical 

<ObjectDescription> [DE] in this information unit the editor can make an analytical         

description of the Object [TY] compound [FI] na, [OB] optional, [MU] unique, 

[DC] structure 

                        It breaks into the following: 

           <RecordingInformation> [DE] contains information about the recording of  

the description of the object [TY] compound, [FI] na, [OB] optional, [MU]  

unique, [DC] structure 

                         It breaks into the following: 

           <RecordingDate> [DE] contains the date when the recording took 

place [TY] simple [FI] from calendar [OB] optional, [MU] unique, 

[DC] date 

<PersonInvolved> [DE] contains the link to the Person which did the 

recording [TY] simple [FI] controlled vocabulary, [OB] optional, [MU] 

unique, [DC] link to the Person  entity 

           <ObservationLocation> [DE] contains the link the the related Location 

where the recording took place [TY] simple [FI] controlled 

vocabulary, [OB] optional, [MU] unique, [DC] link to the Location  

entity 

           <PrincipalMaterial> [DE] contains the link the the main Materials of which the 

Object is created [TY] simple [FI] controlled vocabulary, [OB] optional, [MU] 

multiple, [DC] link to the Material  entity, 

           <PrincipalColor> [DE] contains the main color name of the Object [TY] simple 

[FI] controlled vocabulary, [OB] optional, [MU] multiple, [DC] termfrom list 

<ObjectDimensions> [DE] contains information about the dimensions of  

the object [TY] compound, [FI] na, [OB] optional, [MU] unique  [DC]  

structure, [RE]Can be chosen for use  in the Report 

                        It breaks into the following: 

                        <Dimension> [DE] contains information about the dimensions of the 

                        object [TY] compound, [FI] na, [OB] optional, [MU] multiple  [DC]  

                         structure 

               It breaks into the following: 

<Type> [DE] Contains the type of the dimension (eg. depth, 

height etc.) , [TY] simple, [FI] controlled vocabulary, [OB] 

optional, [MU] unique, [DC] term from list 

<Unit> [DE] Contains the counting unit of the dimension (eg. 

cm, pixels, etc.), [TY] simple, [FI] controlled vocabulary, 

[OB] optional, [MU] unique, [DC] term from list 

<Value> [DE] Contains the value of the dimension, [TY] 

simple, [FI] manual, [OB] optional, [MU] unique, [DC] string 
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           <Decoration> [DE] contains information about decorations of the Object [TY] 

compound [FI] na, [OB] optional, [MU] multiple, [DC] structure 

It breaks into the following: 

                      <PlacementwithintheObject> [DE] defines the exact location that the  

                      specific kind of decoration has on the Object, [TY] simple [FI]   

                       manual, [OB] optional, [MU] unique, [DC] string                       

                      <Subject> [DE] contains the subject of the decoration [TY] simple  

[FI] manual, [OB] optional, [MU] unique, [DC] string                                                         

        <Type> [DE] contains the type of the decoration [TY] simple [FI]   

                       controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list                                                                               

                      <Description> [DE] contains the description of the decoration [TY]  

                                simple [FI] manual, [OB] optional, [MU] unique, [DC] string                                                                                                       

                     <ConstructionTechnique> [DE] contains the construction technique  

of  the decoration [TY] simple [FI] controlled vocabulary, [OB]  

optional, [MU] unique,  [DC] term from list                                                                                                                              

         <Note> [DE] contains a comment about the decoration [TY] simple   

[FI] manual, [OB] optional, [MU] unique, [DC] string   

                     <SiteInformation> [DE] contains a summary of the information that  

is included in the fields [TY] simple [FI] manual, [OB] optional, [MU]  

                      unique, [DC] string                                                                                                                                                                                           

           <Inscription> [DE] contains information about inscriptions on the Object [TY] 

compound [FI] na, [OB] optional, [MU] multiple, [DC] structure 

                       It breaks into the following: 

                              <Type> [DE] contains the type of the inscription [TY] simple [FI]   

                       manual, [OB] optional, [MU] unique, [DC] string                                                                                

                      <Content> [DE] renders the content of the inscription [TY] compound   

                      [FI] na, [OB] optional, [MU] unique, [DC] structure 

                       It breaks into the following: 

                              <Transliteration> [DE] contains the transliteration of the   

                      content in text format,  [TY] simple [FI]  manual, [OB]  

                      optional, [MU] unique, [DC] string                                                                                

                      < Language > [DE] contains the language in which the content  

                     of the inscription is written in [TY] simple [FI]  manual, [OB]  

                      optional, [MU] unique, [DC] string           

                              <Translation> [DE] contains the content translation[TY]  

                                        compound  [FI] na, [OB] optional, [MU] unique, [DC] structure 

                       It breaks into the following: 

                              <Text> [DE] contains the text of the translation[TY]   

                      simple [FI] manual, [OB] optional, [MU] unique, [DC]  

                      string                                                                                

                                <Language> [DE] contains the language in which the  

                               content of the translation is written in [TY] simple   
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                               [FI] manual, [OB] optional, [MU] unique, [DC] string 

                      <Representation> [DE] representation of the decoration in a  

                     photograph or drawing [TY] simple [FI] manual, [OB] optional, [MU]  

                      unique, [DC] string           

                    <Date> [DE] The date of the mark creation [TY] simple [FI] manual,  

                      [OB] optional, [MU] unique, [DC] date/ specific syntax                                                                                                       

                      <Position> [DE] contains the position of the inscription on the object  

                                [TY] simple [FI] manual, [OB] optional, [MU] unique, [DC] string                                                                                                       

                     <Condition> [DE] contains the description of the condition of the  

                      inscription [TY] simple [FI] manual, [OB] optional, [MU] unique,   

                                [DC] string    

                     <Measurement> [DE] contains the size of the inscription [TY] simple             

                     [FI] manual, [OB] optional, [MU] unique, [DC] string                                                                                                                                                                                                                                                          

                             <Technique> [DE] contains the technique with which the inscription  

                       was created, [TY] simple, [FI] manual, [OB] optional, [MU] unique,  

                       [DC] string   

                                  <Material> [DE] The construction material of the mark, [TY] simple  

                                   [FI] controlled vocabulary [OB] optional, [MU] unique, [DC] string,  

                                   link to Material  entity 

                                  <Objective> [DE] contains the objective of the mark, [TY] simple  

                       [TY] simple, [FI] manual, [OB] optional, [MU] unique, [DC] string 

                     <Note> [DE] contains a comment about the mark  [TY] simple, [FI]           

                      manual, [OB] optional, [MU] unique, [DC] string   

                    <SiteInformation> [DE] contains a summary of the information that is 

                     included in the fields [TY] simple [FI] manual, [OB] optional, [MU]  

                    unique, [DC] string 

           <Condition Report> [DE] contains information about the condition of the 

Object [TY] compound [FI] na, [OB] optional, [MU] unique, [DC] structure 

                       It breaks into the following: 

                      <MacroscopicExamination> [DE] contains information about the   

                       condition of the object as observed without the use of devices 

                       [TY] compound [FI] na, [OB] optional, [MU] unique, [DC] structure 

                       It breaks into the following: 

                              <Observation> [DE] ] contains information about the   

                       condition of the object as observed without the use of devices 

             [TY] simple [FI]  manual, [OB] optional, [MU] multiple, [DC]                     

              String, [RE] can be chosen for use in the Report 

    It breaks into the following: 

            <Feature> [DE] contains the name of the feature of the   

    object that is observed(or the name of the whole object),    

    [TY] simple [FI]  manual, [OB] optional, [MU] unique, [DC]   

    String 
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    <Type> [DE] contains the type of the feature of the   

    object that is observed,  [TY] simple [FI]  manual, [OB]  

               optional, [MU] unique, [DC] string 

    <PreservationCondition> [DE] contains the description of   

     the condition of the feature,  [TY] simple [FI]  manual,    

    [OB] optional, [MU] unique, [DC] string 

                     <Note> [DE] contains a note about the condition of the object [TY] 

                      simple [FI] manual, [OB] optional, [MU] unique, [DC] string , [RE]  

can be chosen for use in the Report                           

<ObjectHistory> [DE] in this information unit the editor can add information about 

the history of the Object [TY] compound [FI] na, [OB] optional, [MU] unique, [DC]   

structure 

                        It breaks into the following: 

           <CreationInformation> [DE] contains information about the creation of the 

           object [TY] compound, [FI] na, [OB] optional, [MU] unique, [DC] structure 

   It breaks into the following: 

                         <Creator> [DE] contains information about the creator of the object  

                          [TY] compound [FI] na [OB] optional, [MU] unique, [DC] structure, 

                          [RE] can be chosen for use in the Report 

               It breaks into the following: 

                                   <Person> [DE] contains the link to the individual creator of   

                                      the object [TY] simple [FI] controlled vocabullary [OB] 

                                      optional, [MU] unique, [DC] link to Person  entity 

                                   <Organization> [DE] contains the link to the organization/  

                                     creator of the object [TY] simple [FI] controlled vocabullary  

                                     [OB] optional, [MU] unique, [DC] link to Organization   

   entity 

                                    <Creation date> [DE] contains the creation date or period of   

                                  the object [TY] simple [FI] manual  [OB] optional, [MU]  

                                   unique, [DC] date/ specific syntax, [RE] can be chosen for use in the  

Report 

                                            View: 6.2.4  Fields of Time and Date Expressions 

                       <Creation Location> [DE] contains the link to the location were the   

                       object was created [TY] simple [FI] controlled vocabullary [OB]   

                          optional, [MU] unique, [DC] link to Location entity 

                                   <ConstructionTechnique> [DE] contains the construction technique  

of the object  [TY] simple [FI] controlled vocabullary [OB] optional, 

[MU] unique, [DC] term from list 

                       <ToolsUsed> [DE] contains the tools that were used for the  

                        construction of the object [TY] simple [FI] controlled vocabullary  

[OB] optional, [MU] unique, [DC] term from list 

           <CurrentOwner> [DE] contains information about the currentowner of the 
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           object [TY] compound, [FI] na, [OB] optional, [MU] unique, [DC] structure,    

            [RE] can be chosen for use in the Report 

   It breaks into the following: 

                         <PersonInvolved> [DE] contains the link to the individual current                  

                          owner of  the object [TY] simple [FI] controlled vocabullary [OB]  

                          optional, [MU] multiple, [DC] link to Person  entity 

<OrganizationInvolved> [DE] contains the link to the current owner 

organization of  the object [TY] simple [FI] controlled 

vocabullary[OB] optional, [MU] multiple, [DC] link to Organization  

entity 

<Note> [DE] contains a comment about the owner  [TY] simple, [FI] 

manual, [OB] optional, [MU] unique, [DC] string   

           <FieldCollection> [DE] contains information about the currentowner of the 

           object [TY] compound, [FI] na, [OB] optional, [MU] unique, [DC] structure 

   It breaks into the following: 

                                    <Date> [DE] contains the date or period that the object was found 

                                    [TY] simple [FI] manual  [OB] optional, [MU] unique, [DC] date/  

                                      specific syntax view  

                                               View: 6.2.4  Fields of Time and Date Expressions 

                         < Location> [DE] contains the link to the location were the   

                         object was found[TY] simple [FI] controlled vocabullary [OB]   

                          optional, [MU] unique, [DC] link to Location entity 

                        <Note> [DE] contains a comment about the field collection of the  

                         object  [TY] simple, [FI] manual, [OB] optional, [MU] unique, [DC] 

                         string   

           <Interventions> [DE] This information unit refers to the interventions  

            performed on the object. [TY] compound, [FI] na, [OB] optional, [MU]  

            multiple, [DC] structure 

   It breaks into the following: 

                         < Type> [DE] contains the type of the intervention [TY] simple [FI]   

                          manual [OB] optional, [MU] unique, [DC] string 

                                    <Date> [DE] contains the date or period that the intervention  

                                     happened [TY] simple [FI] manual  [OB] optional, [MU] unique, 

                                     [DC] date/ specific syntax view 

                                     View: 6.2.4  Fields of Time and Date Expressions 

                         < Location> [DE] contains the link to the location were the   

                         Intervention took place [TY] simple [FI] controlled vocabullary [OB]   

                          optional, [MU] unique, [DC] link to Location  entity 

                         <PersonInvolved> [DE] contains the link to the person that  

                          participated in the intervention [TY] simple [FI] controlled               

                          vocabullary [OB] optional, [MU] multiple, [DC] link to Person  entity 

                         <OrganizationInvolved> [DE] contains the link to the  
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                         organization that participated in the intervention [TY] simple [FI]  

                         controlled vocabullary [OB] optional, [MU] multiple, [DC] link to  

                        Organization  entity 

                       <Note> [DE] contains a comment about the intervention  [TY]  

                         simple, [FI] manual, [OB] optional, [MU] unique, [DC] string   

                       <SiteInformation> [DE] contains a summary of the information that  

                         is included in the fields [TY] simple [FI] manual, [OB] optional,  

                         [MU] unique, [DC] string 

 Project 5.3.2

 

      [DE] in this funcional unit the information about the project in which the object has been 

involved is documented, [TY] compound,  [FI]na,  [OB] optional, [MU] multiple,  [DC] structure 

It breaks into the following: 

          <LinkToProject> [DE] this information unit includes the link to the related Project [TY] 

simple [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] link to Project  

entity 

          <RelatedTechnicalExamination> [DE] this information unit includes information of the 

related Technical examinations that were applied to the Object during the specific 

Project [TY] compound [FI] na, [OB] optional, [MU] multiple, [DC] structure                     

            It breaks into the following: 

           <Method> [DE] the name of the Technical Examination [TY] simple [FI] 

controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list 

           <Link> [DE] this field includes the link of the related Technical examination 

[TY] simple [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] link 

to the Technical Examination entities 

           <Status> [DE] this field includes the status of the Project [TY] simple [FI] 

controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list 

 <GeneralNote> [DE] this field includes a comment about the Project   [TY] simple,   

 [FI] manual, [OB] optional, [MU] unique, [DC] string   

 Bibliographic Reference 5.3.3

 

     See the relative chapter: 7.2 Bibliographic Reference 

 Archival Reference 5.3.4

    [DE] in this funcional unit the editor can enter information about a related bibliographic 

reference. The diference here with the “Bibliographic Reference” information unit is that the editor 

doesn’t need to create a new bibliographic entity. In this information unit just a link or a note is 

acquired , [TY] compound,  [FI]na,  [OB] optional, [MU] multiple,  [DC] structure 

It breaks into the following: 
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          <Link> [DE] In this field the editor can add a link to the bibliographic reference (e.g. 

the electronic address of a paper) [TY] manual [FI] text, [OB] optional, [MU] unique, 

[DC] text 

          <Note> In this field the editor can add a note about the bibliographic reference [TY] 

manual [FI] text, [OB] optional, [MU] unique, [DC] text 

 

 Card Identity 5.3.5

 

See the related chapter: 7.1 Card Identity 

 

The field Related Glossary appears when a conection is made from the Glossary entity to the Object. 

The field Related Data appears when a conection is made from the Data entity to the Object. 

The field Related Technical examinations appears when a conection is made from the 

LIBS/RAMAN/MULTISPECTRAL  entity to the Object. 

The field Related Examples appears when a conection is made from the Examples entity to the 

Object. 

  

 

 Digital Object 5.4

This entity is also used for documentation and presentation reasons simultaneously. The fields 

used only for documentation, that are not presented in the “Polygnosis” website are marked with a 

light grey color. 

A Digital Object has to be linked with an “Example” entity in order to appear in the “Polygnosis” 

website. The linking is made at the field “Documentation” or “Diagnosis” of the “Example” entity. That 

way only Digital objects that are related to specific examples of conservation or studies, appear in the 

“Polygnosis” website at the Data section. 

 

 Basic Digital Object Information 5.4.1

 

        [DE] This functional unit contains the basic information about a digital object, [TY] 

compound,[FI]na,[OB]optional,[MU]unique,[DC]structure 

It breaks into the following: 

<Digital Object Title> [DE] Contains the title of the digital object, [TY] simple, [FI]  

manual, [OB] obligatory, [MU] unique, [DC] string 

<Digital Object Type> [DE] Contains the type of the digital object, [TY] simple, [FI] 

controlled vocabulary, [OB] optional, [MU] multiple, [DC] term from list 

<Digital Object Subject> [DE] Contains the subject of the digital object, [TY] simple, [FI] 

manually, [OB] optional, [MU] multiple, [DC] string 
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           <Digital File> [DE] Contains the digital file of the digital object, [TY] simple, [FI]  

PC/server upload, [OB] obligatory, [MU] unique, [DC] file 

<Digital Rights> [DE] Contains the digital rights of the digital object, [TY] simple, [FI] 

controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list 

<Storage Location> [DE] Contains the storage location of the digital object, [TY]  

simple, [FI] manual, [OB] optional, [MU] unique, [DC] string 

<Dimension> [DE] Contains information about the dimension of the digital object,  

[TY] compound, [FI] na, [OB] optional, [MU] multiple, [DC] na 

It breaks into the following: 

<Type> [DE] Contains the type of the dimension (eg. depth, height, etc.), [TY]  

simple [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] term from 

list 

<Unit> [DE] Contains the counting unit of the dimension(eg. cm, pixels, etc.), [TY] 

simple [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] term from 

list 

<Value> [DE] Contains the value of the dimension, [TY] simple [FI] manual,  

[OB] optional, [MU] unique, [DC] string 

 Creation Information 5.4.2

 

        [DE] This functional unit contains the basic information about the creation of the digital 

object, [TY] compound, [FI] na, [OB] optional, [MU] unique, [DC] na 

It breaks into the following: 

<Type> [DE] Contains the type of the creation method (eg. LIBS or Photography), [TY]  

  simple, [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list 

<Creation Date> [DE] Contains information on the date of creation, [TY] simple,  

[FI] choose from calendar, [OB] optional, [MU] unique, [DC] date,  

<Creator> [DE] Contains the link to the creator of the digital object, [TY] simple, [FI] 

controlled vocabulary, [OB] optional, [MU] unique, [DC] link to the Person entity 

<Creation Location> [DE] Contains the link to the location where the digital object was  

created, [TY] simple, [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] link  

to the Location entity 

<Technical Characteristics> [DE] Contains information about the technical  

characteristics of the digital object, [TY] simple, [FI] manual, [OB] optional, [MU]  

unique, [DC] string 

 Source 5.4.3

 

        [DE] This functional unit contains information about the source of the digital object, [TY] 

compound, [FI] na, [OB] optional, [MU] unique, [DC] na 

It breaks into the following: 

<Link> [DE] Contains the link to the source of the digital object that may be a technical  
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examination or an object etc , [TY] simple, [FI] controlled vocabulary, [OB]  

optional, [MU] unique, [DC] link to the LIBS/RAMAN/Multispectral/Object entities 

<Type> [DE] Contains the type of the source (eg. object, Technical examination etc.). , [TY]  

simple, [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] term from list 

<Description> [DE] Contains the description of the source, (eg. in case the source is a URL  

it should be included here) [TY] simple, [FI] manual, [OB] optional, [MU] unique, [DC] string 

 Comment 5.4.4

 

        [DE] In this field the editor can insert any comment related to the digital object, [TY] 

simple, [FI] manual, [OB] optional, [MU] unique, [DC] string 

 Description 5.4.5

 

      [DE] In this field the editor can insert the description of the digital object, [TY] 

simple, [FI] manual, [OB] optional, [MU] multiple, [DC] string 

 Related Glossary 5.4.6

 

      [DE] In this field the editor can link a term that is related to the specific  digital object, 

      [TY] linking, [FI] manual, [OB] optional, [MU] multiple, [DC] link to entity Glossary 

 Related Object 5.4.7

 

      [DE] In this field the editor can link an Object  and the kind of relation between that 

       Object and the digital object,[TY] linking, [FI] manual, [OB] optional, [MU] multiple, 

       [DC] link to entity Glossary 

 Related Digital Object 5.4.8

 

      [DE] In this field the editor can make a link with another Digital Object and the kind of 

       relation between those two digital objects,[TY] linking, [FI] manual, [OB] optional, [MU] 

       multiple,[DC] link to entity Glossary 

 

 Aim 5.4.9

 

        [DE] Contains the aim of using the digital object. By choosing the term “site-Digital 

Object” the Digital Object is presented in the Polygnosis website , [TY] simple, [FI] controlled 

vocabulary, [OB] optional, [MU] multiple, [DC] term from list 

 Was Used To 5.4.10

 

        [DE] Contains the link to the related technical examination where the digital object was 
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used, [TY] simple, [FI] controlled vocabulary, [OB] optional, [MU] multiple, [DC] link to Technical 

Examinations  entity 

 Bibliographic Reference 5.4.11

 

See the related chapter: 7.2 Bibliographic Reference  

 Card Identity 5.4.12

 

See the related chapter: 7.1 Card Identity 
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6 Description of entities, used for presentation in the 

Polygnosis Website 

The following entities are entirely used for presentation at the Polygnosis Web site.  

 Method Application 6.1

In the records of this entity the fields that send information to the first column and row of the 

table of the Best Practice Guide for Technical examination can be found. Also the general information 

that appears in relation to the application of a Technical examination and a specific evidence, when 

choosing “see more” at the table, can be found here. 

 Criss Crossed Title 6.1.1

        [DE] This field contains the title of the method application that consists of the           

evidence type and the technical examination, [TY] simple, [FI] manual, [OB] obligatory, [MU]unique, 

[DC] string 

 Evidence Type 6.1.2

 

           [DE] Contains information on the type of evidence, [TY] compound, [FI] na, [OB] 

optional, [MU] unique, [DC] na 

It breaks into the following: 

<Hierarchy> [DE] Contains the hierarchy of the evidence type terms, [TY] compound, 

 [FI] na, [OB] optional, [MU] unique, [DC] structure 

It breaks into the following: 

           <Term> [DE] Contains the link to the term that describes the specific evidence type, 

[TY] simple, [FI] controlled vocabulary,  [OB] optional, [MU] unique, [DC] link to the 

Glossary  entity 

           <Broader Term> [DE] In this field the connection to the broader  term is done 

automatically when the editor has entered the term in the field above, [TY] simple 

[FI] automatically [OB] obligatory, [MU] unique, [DC] na 

 Examination Type 6.1.3

 

           [DE] Contains information on the type of examination technique, [TY] compound, [FI] 

na, [OB] optional, [MU] unique, [DC] structure 

It breaks into the following: 

<Hierarchy> [DE] Contains the hierarchy of the examination type terms, [TY] compound, 

 [FI] na, [OB] optional, [MU] unique, [DC] structure 

It breaks into the following: 
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           <Term> [DE] Contains the link to the term for the examination technique, [TY] 

simple, [FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] link to the 

Glossary entity 

           <Broader Term> [DE] In this field the connection to the broader  term is done 

automatically when the editor has entered the term in the field above, [TY] simple 

[FI] automatically [OB] obligatory, [MU] unique, [DC] na 

 

 Description 6.1.4

 

       [DE] This field contains a general description of the method application, [TY] simple, [FI] 

manual, [OB] optional, [MU] unique, [DC] string 

 

 Components 6.1.5

 

               See the relative chapter: 7.3 Components 

 

 Bibliographic Reference 6.1.6

 

See the related chapter: 7.2 Bibliography 

 Examples 6.1.7

 

       [DE] Contains the  examples that are related to the method application, [TY] compound, 

[FI] na, [OB] optional, [MU] unique, [DC] structure,  

It breaks into the following: 

<Example> [DE] Contains the link to the related example, [TY] simple ,[FI] controlled 

vocabulary , [OB] optional, [MU]  multiple, [DC] link to the Examples  entity 

 Card Identity 6.1.8

 

See the related chapter: 7.1 Card Identity 

 Conservation Application 6.2

In the records of this entity the fields that send information to the first column and row of the 

table of the Best Practice Guide for Laser Cleaning can be found. Also the general information that 

appears in relation to the application of a Technical examination and a specific evidence, when 

choosing “see more” at the table, can be found here. 
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 Criss Crossed Title 6.2.1

 

        [DE] This field contains the title of the method application that consists of the           

evidence type and the technical examination, [TY] simple, [FI] manual, [OB] obligatory, [MU]unique, 

[DC] string 

 Evidence Type 6.2.2

 

           <Term> [DE] Contains the link to the term that describes the specific evidence type 

that was the subject of the cleaning, [TY] simple, [FI] controlled vocabulary,  [OB] 

optional, [MU] unique, [DC] link to the Glossary  entity 

 Device Type 6.2.3

 

           <Term> [DE] Contains the link to the term that describes the specific device type that   

            was used for the cleaning,  [TY] simple, [FI] controlled vocabulary,  [OB] optional,  

            [MU] unique, [DC] link to the Glossary  entity 

 Description 6.2.4

 

       [DE] This field contains a general description of the cleaning studies or application, [TY] 

simple, [FI] manual, [OB] optional, [MU] unique, [DC] string 

 

 Bibliographic Reference 6.2.5

 

See the related chapter: 7.2 Bibliography 

 Examples 6.2.6

 

       [DE] Contains the  examples that are related to the cleaning studies or application, [TY]   

       compound, [FI] na, [OB] optional, [MU] unique, [DC] structure, 

It breaks into the following: 

<Example> [DE] Contains the link to the related example, [TY] simple ,[FI] controlled 

vocabulary , [OB] optional, [MU]  multiple, [DC] link to the Examples  entity 

 Card Identity 6.2.7

 

See the related chapter: 7.1 Card Identity 
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 Example 6.2

 Title 6.2.1

 

        [DE] This field contains the title of the example, [TY] simple, [FI] manual, [OB] 

obligatory, [MU]unique, [DC] string 

 Example of 6.2.2

 

        [DE] In this field the connection to the related  method application’s record or 

Conservation Application is done automatically when the editor has made the connection through the 

method application’s or conservation applications record, [TY] simple, [FI] automatically, [OB] na, 

[MU]unique, [DC] link to Method Application  or Conservation Application entity 

 Object Involved 6.2.3

 

        [DE] This field contains the link to the involved object record, [TY] simple, [FI] controlled 

vocabulary, [OB] obligatory, [MU]unique, [DC] link to Object  entity 

 Examination 6.2.4

 

           [DE] Contains information on the examination done in the particular example, [TY] 

compound, [FI] na, [OB] optional, [MU] unique, [DC] structure 

It breaks into the following: 

<Description> [DE] Contains the description of the examination, [TY] simple, 

 [FI] manual, [OB] optional, [MU] unique, [DC] string 

 

 Documentation 6.2.5

 

           [DE] Contains information about the outcomes of the specific method or cleaning 

application  , [TY] compound, [FI] na, [OB] optional, [MU] unique, [DC] structure 

It breaks into the following: 

<Digital object> [DE] Contains information on the digital object that is an outcome of the 

process, [TY] compound, [FI] na, [OB]  optional, [MU] multiple, [DC] structure 

<Link> [DE] Contains the link to the digital object, [TY] simple, [FI] controlled  

vocabulary,  [OB] optional, [MU] unique, [DC] link to the Digital object  entity 

 

The “comment” field has to be filled in at the related field of the Digital Object record. 

 Diagnosis 6.2.6

           [DE] Contains information on the diagnosis made in the particular example, [TY] 

compound, [FI] na, [OB] optional, [MU] unique, [DC] structure 
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It breaks into the following: 

<Title> [DE] Contains the title of the diagnosis or the result of cleaning, [TY] simple, [FI] 

manual, [OB]   optional, [MU] unique, [DC] string 

<Description> [DE] Contains the description of the diagnosis, [TY] simple, [FI] manual, [OB] 

optional, [MU] unique, [DC] string 

<Digital object> [DE] Contains information on the digital object that is related to the 

diagnosis, [TY] compound, [FI] na, [OB]  optional, [MU] multiple, [DC] structure  

It breaks into the following: 

           <Link> [DE] Contains the link to the digital object, [TY] simple, [FI] controlled 

vocabulary,  [OB] optional, [MU] unique, [DC] link to the Digital object  entity 

          <Comment> [DE] Contains comments on the digital object, [TY] simple, [FI] manual,  

[OB] optional, [MU] unique, [DC] string 

 Bibliographic Reference 6.2.7

 

See the related chapter: 7.2 Bibliographic Reference 

 Card Identity 6.2.8

 

See the related chapter: 7.1 Card Identity 

 

 Glossary 6.3
 

A Glossary record has to be linked with an “Example” record in order to appear in the “Polygnosis” 

website. The linking is made at the field “Related Glossary” of the “Example” entity records. That way 

only Glossary terms that are related to specific examples of conservation or studies, appear in the 

“Polygnosis” website at the Glossary section. 

 Basic Term Information 6.3.1

 

        [DE] This functional unit contains the basic information about the term, [TY] compound, 

[FI] na,[OB] optional, [MU] unique, [DC] structural 

It breaks into the following: 

<Term> [DE] Contains the term itself, [TY] simple, [FI] controlled vocabulary, [OB]  

obligatory, [MU] unique, [DC] term from list 

<Term Type> [DE] Contains the type of the term, [TY] simple, [FI] controlled  

vocabulary, [OB] optional, [MU] unique, [DC] term from list 

<Facet> [DE] Contains the facet (the highest category), [TY] simple, [FI]  controlled  

vocabulary, [OB] optional, [MU] unique, [DC] term from list 

  <Hierarchy> [DE] Contains the hierarchy (top term/broader term), [TY]  compound, [FI] na, 

[OB] optional, [MU] multiple, [DC] structure 
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It breaks into the following: 

           <Top Term> [DE] Contains the link to the top term, [TY] simple, [FI] controlled 

vocabulary, [OB] optional, [MU] unique, [DC] link to the Glossary  entity           

<Broader Term> [DE] Contains the link to the broader term, [TY] simple, [FI] 

controlled vocabulary,  [OB] optional, [MU] unique, [DC] link to the Glossary  entity 

  <Description> [DE] Contains information about the description of the term, [TY]  

compound,[FI] na, [OB] optional, [MU] unique, [DC] na 

It breaks into the following: 

           <Source> [DE] Contains the link to the source of the term’s description, [TY] simple, 

[FI] controlled vocabulary, [OB] optional, [MU] unique, [DC] link to the Bibliography  

entity 

           <Text> [DE] Contains the text of the description, [TY] simple, [FI] manual,  [OB] 

optional, [MU] unique, [DC] string 

 Related Glossary 6.3.2

 

 

       [DE] Contains related terms to the specific term of the record [TY] compound, [FI] na, 

[OB] optional, [MU] unique, [DC] structure 

It breaks into the following: 

<Term> [DE] Contains the link to the related term, [TY] simple ,[FI] controlled vocabulary , 

[OB] optional, [MU]  multiple, [DC] link to the Glossary  entity 

 

 Bibliographic Reference 6.3.3

 

See the related chapter: 7.2 Bibliographic Reference 

 

 Card Identity 6.3.4

 

See the related chapter: 7.1 Card Identity 


